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センサの接続について 

以下にセンサの接続方法を示します。センサの種類により、接続方法は異なります。接続に必要なケーブルを

用意してください。マイクロホンのプリアンプはNH-22のみ使用可能です。 

 

・マイクロホン(UC-52/UC-59)とプリアンプ(NH-22) 

マイクロホンとNH-22は直接接続します。NH-22とDA-21間はBNCケーブル(EC-90シリーズ)を使って接

続します。 

 

・増幅器内蔵加速度ピックアップ(PV-41/PV-91C/97I) 

BNCアダプタVP-52Cを使って接続します。ピックアップとVP-52C間はVP-51シリーズを使って接続しま

す。VP-52CはDA-21に直接接続します。 

 

・加速度ピックアップ(PV-65/PV-85/PV-87/PV-90B/PV-97C)とチャージコンバータ(VP-40) 

ピックアップとVP-40間はVP-51シリーズを使って接続します。VP-40はDA-21に直接接続します。 

 

・騒音計 

騒音計の交流出力から接続コード(CC-24/CC-24S/NC-39A/EC-90A/EC-90B:機種によって異なる)を使って接続

します。 

 

・振動計  

振動計の交流出力から接続コード(CC-24/CC-24S/NC-39A/EC-90A/EC-90B:機種によって異なる)を使って接続

します。 

 

・振動レベル計  

振動レベル計の交流出力から接続コード(NC-39A/EC-90A/EC-90B)を使って接続します。 

 

・増幅器内蔵インパルスハンマ 

ダイトラン製のインパルスハンマ等はEC-90シリーズを使って接続します。 

 

・回転計 

BNC入力になっています。ご使用の回転計の出力に合わせてケーブルを選定します。 
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MENU System 

Read / Save Setting 

Clock Setting 

Date                  2014/04/03 

Time                  14:43:31 

Backlight Setting 

Brightness            2 

  Auto Off              30 s 

Battery Type            Alkaline 

Card Format 

USB Storage             OFF 

Monitor Out             ON 

Index                   1 

Version                 1.0 

初めに 

 SDカードについて 

 本器はSDカードが無いと収録、及び再生が行なえません。また、SDカードは弊社販売品をお使いください。

それ以外は動作の保障がされません。 

 

 初期設定 

 電源投入後、最初に以下の操作を行なってください。 

・MENU キーを押してメニュー画面を表示させます。 

・[System]にカーソルを移動してENTER キーを押して、 

右の画面を表示させます。 

  ・[Clock Setting]で時刻を設定します。 

・[BackLight Setting]の[Brightness]にカーソルを移動して 

ENT キーを押して、▲ ▼キーを使って見やすい明る 

さに設定します。また、電池の寿命を長くするために 

一定時間キー操作が無い時にLCDバックライトを自 

動的に消灯する場合は、[Auto Off] にカーソルを移動 

してENT キーを押して、▲ ▼キーを使って設定しま 

す。 

  ・[Battery Type]で使用する電池のタイプを設定します。 

  ・本器で初めて使用するSDカードは、[Card Format] に 

カーソルを移動して、ENT キーを押してフォーマット 

してください。また、収録済みデータを全て消去して良い場合もこの操作を行って消去できます。以前収 

録したデータが入ったままですと収録時間が短くなります。 

・本器とパソコンをUSBケーブルで接続し、パソコンから本器をリムーバブルディスクとして認識し、SD 

カード内のデータをパソコンに取り込む場合は、[USB Storage] にカーソルを移動してENTキーを押して、 

▲ ▼キーを使ってONにしてデータを取り込みます。取り込み終了後はOFFに設定します。ONのまま

ではデータの収録が行えません。 

  ・モニタ出力を使用する場合は、[Monitor Out]をONにします。 
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MENU  Input 

CHInp    HPF   LPF    Sens  Sensitivity 

1：CCLD  OFF   OFF    MIC  -28.4     dB 

2：OFF   OFF   OFF    V 

3：OFF  OFF   OFF    V 

4：OFF   OFF   OFF    V 

5：OFF  

MENU  Input 

CHInp    HPF   LPF    Sens  Sensitivity 

1：CCLD  OFF   OFF    V 

2：OFF   OFF   OFF    V 

3：OFF  OFF   OFF    V 

4：OFF   OFF   OFF    V 

5：OFF  

接続方法による設定と校正 

使用する入力信号を参照してください。 

■ マイクロホン(UC-52/UC-59)とプリアンプ(NH-22) 

  マイクロホンの種類が変わっても設定と校正の方法は変わりません。CH1のみ使用した場合で示します。

CH2以降も使用する場合は同様に行います。 

マイクロホンの校正方法は、マイクロホン感度レベルを入力する方法と、音響校正器またはピストンホンを 

用いて校正信号を記録する方法(校正信号を収録して、再生時、および分析時にその信号を基準にレベル変換) 

があります。 

○マイクロホン感度レベルを入力することによる校正 

・MENU キーを押して、メニュー画面を表示させます。 

・[INPUT]にカーソルを移動してENTER キーを押して、   

右の画面のように設定します。ただし、必要に応じて 

HPFとLPFは設定してください。 

CH1に感度レベル-27.6 dBのマイクロホン  

(UC-52/UC-59)とNH-22(UC-52/UC-59の場合のプリア 

ンプ増幅度は-0.8 dB)を接続した場合、Sens、Sensitivity 

には、(校正値)=(マイクロホン感度レベル) + (プリアンプ増幅度)から求め、-27.6 - 0.8 = -28.4 になります。 

・MENU キーを押して、メニュー画面を表示させます。 

・再度MENU キーを押して、メニュー画面から抜けます(測定画面になります)。 

○音響校正器またはピストンホンを用いて校正 

・MENU キーを押して、メニュー画面を表示させます。 

・[INPUT]にカーソルを移動してENTER キーを押して、     

右の画面のように設定します。ただし、必要に応じ 

てHPFとLPFは設定してください。 

・MENU キーを押して、メニュー画面を表示させます。 

・再度MENU キーを押して、メニュー画面から抜けま 

す(測定画面になります)。 

・7ページの収録前設定を行います。 

・音響校正器またはピストンホンをマイクロホンに挿してONにします。 

・REC キーを押して校正信号を収録します。 

・10秒程度収録して停止(STOP キーを押す)します。 

・音響校正器またはピストンホンをOFFにして抜きます。 

・停止した場合、9ページのデータの収録に移行し、測定準備完了後、REC キーを押して、測定を開始し 

ます。 
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MENU  Input 

CHInp    HPF   LPF    Sens  Sensitivity 

1：CCLD  OFF   OFF    PICK 1.02E+00mV/m/s2 

2：OFF   OFF   OFF    V 

3：OFF  OFF   OFF    V 

4：OFF   OFF   OFF    V 

5：OFF  

MENU  Input 

CHInp    HPF   LPF    Sens  Sensitivity 

1：VP4x  OFF   OFF    PICK 6.42E+00pc/m/s2 

2：OFF   OFF   OFF    V 

3：OFF  OFF   OFF    V 

4：OFF   OFF   OFF    V 

5：OFF  

MENU  Input 

CHInp    HPF   LPF    Sens  Sensitivity 

1：OFF  OFF   OFF    V 

2：OFF   OFF   OFF    V 

3：OFF  OFF   OFF    V 

4：OFF   OFF   OFF    V 

5：Tacho 

Pulse / Rotation       10 

■ 増幅器内蔵加速度ピックアップ(PV-41/PV-91C/PV-97I) 

ピックアップの種類が違っても設定と校正の方法は変わりません。CH1のみ使用した場合で示します。CH2

以降も使用する場合は同様に行います。 

・MENU キーを押して、メニュー画面を表示させます。 

・[INPUT]にカーソルを移動してENTER キーを押して、以下の画面のように設定します。ただし、必要に 

応じてHPFとLPFは設定してください。 

CH1に感度レベル1.02 mV/(m/s
2
)の加速度ピック 

アップを接続した場合、Sens、Sensitivityには右の 

画面のように設定します。 

・MENU キーを押して、メニュー画面を表示させ 

ます。 

・再度MENU キーを押して、メニュー画面から 

抜けます(測定画面になります)。 

 

■ 加速度ピックアップ(PV-65/PV-85/PV-87/PV-90B/PV-97C)とチャージコンバータ(VP-40) 

ピックアップの種類が違っても設定と校正の方法は変わりません。CH1のみ使用した場合で示します。CH2

以降も使用する場合は同様に行います。 

・MENU キーを押して、メニュー画面を表示させます。 

・[INPUT]にカーソルを移動してENTER キーを押して、以下の画面のように設定します。ただし、必要に 

応じてHPFとLPFは設定してください。 

CH1に感度レベル6.42 pC/(m/s
2
)の加速度ピック 

アップを接続した場合、Sens、Sensitivityには右の 

画面のように設定します。 

・MENU キーを押して、メニュー画面を表示させ 

ます。 

・再度MENU キーを押して、メニュー画面から 

抜けます(測定画面になります)。 

 

■ 回転計 

1回転10パルスの回転計を回転入力端子に接続した場合 

で示します。 

・MENU キーを押して、メニュー画面を表示させます。 

・[INPUT]にカーソルを移動してENTER キーを押して、 

右の画面のように設定します。 

・MENU キーを押して、メニュー画面を表示させます。 

・再度MENU キーを押して、メニュー画面から抜けま 

す(測定画面になります)。 
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MENU  Input 

CHInp    HPF   LPF    Sens  Sensitivity 

1：AC    OFF   OFF    SLM   100      dB 

2：OFF   OFF   OFF    V 

3：OFF  OFF   OFF    V 

4：OFF   OFF   OFF    V 

5：OFF  

MENU  Input 

CHInp    HPF   LPF    Sens  Sensitivity 

1：CCLD  OFF   OFF    EU  2.20E-03V/EU 

2：OFF   OFF   OFF    V 

3：OFF  OFF   OFF    V 

4：OFF   OFF   OFF    V 

5：OFF  

■ 騒音計・振動計・振動レベル計 

騒音計の場合で示します。測定器は異なっても校正の方法は変わりません。CH1のみ使用した場合で示しま

す。CH2以降も使用する場合は同様に行います。 

・MENU キーを押して、メニュー画面を表示させます。 

・[INPUT]にカーソルを移動してENTER キーを押して、 

右の画面のように設定します。ただし、必要に応じてHPF 

とLPFは設定してください。 

騒音計のレベルレンジを100 dBにした場合、Sens、 

Sensitivityは右の画面のように設定します。 

・MENU キーを押して、メニュー画面を表示させます。    

・7ページの収録前設定を行います。 

・騒音計(振動計/振動レベル計)を校正モードにします。 

・REC キーを押して校正信号を収録します。再生時にこの信号レベルを元に各信号レベルを算出しますので、 

レベルを記録しておく必要があります。 

・10秒程度収録して停止(STOP キーを押す)します。 

・騒音計(振動計/振動レベル計)を校正モードから解除します。 

・9ページのデータの収録に移行し、測定準備完了後、REC キーを押して、測定を開始します。 

 

■ 増幅器内蔵インパルスハンマ 

CH1のみ使用した場合で示します。CH2以降も使用する場合は同様に行います。 

・MENU キーを押して、メニュー画面を表示させます。 

・[INPUT]にカーソルを移動してENTER キーを押して、 

右の画面のように設定します。ただし、必要に応じて 

HPFとLPFは設定してください。 

CH1に感度レベル2.20 mV/Nのインパルスハンマを接続 

した場合、SensとSensitivityは右の画面のように設定    

します。 

・MENU キーを押して、メニュー画面を表示させます。 

・再度MENU キーを押して、メニュー画面から抜けます 

(測定画面になります)。 
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MENU  Rec.Parameters 

Frequency  Range          20ｋHz 

Sampling  Frequency      ×2.56 

Bit  Length         16 bit 

Wave  Splitting  Interval  1  h 

Recording  Time          Manual 

Pre  Recording  Time         0 s 

MENU Trigger 

Mode          Repeat 

Type          Level 

Level                   50.0  ％ 

Ch                      Ch.1 

収録前の設定 

 この設定は全ての収録に共通です。 

■ 収録条件の設定 

・MENU キーを押して、メニュー画面を表示させます。 

・[Rec.Parameters]にカーソルを移動してENTER キーを 

押して、右の画面を表示させます。 

  ・[Frequency Range ]にカーソルを移動して ENT キーを押して、 

▲ ▼キーを使って計測したい周波数レンジを設定します。 

・[Sampling Frequency ]にカーソルを移動して ENT キーを押 

して、▲ ▼キーを使ってサンプリング周波数(×2.4/×2.56) 

を設定します。サンプリング周波数は、前記[Frequency Range ]の設定値の2.4倍 / 2.56倍となります。 

・[Bit Length]にカーソルを移動してENT キーを押して、▲ ▼キーを使ってデータ長(16bit/24bit)を設定しま 

す。 

・[Wave Splitting Interval ]にカーソルを移動してENT キーを押して、▲ ▼キーを使って1ファイルの最大収 

録時間(10min/1h)を設定します。 

・[Recording Time ]にカーソルを移動してENT キーを押して、▲ ▼キーを使って収録時間を設定します。 

・[Pre Recording Time ] にカーソルを移動して ENT キーを押して、▲ ▼キーを使ってプリ時間(0s/1s/5s)を設 

定します。 

・MENU キーを押して、メニュー画面を表示させます。 

 

■ 入力レンジの設定 

・Range キーを押して、▲ ▼キーを使って入力レンジを変更するチャンネルにカーソルを移動してENT 

キーを押して、▲ ▼キーを使ってレンジを設定します。この時の設定の目安は、バーグラフの左側のOV 

表示または液晶の左側のOVランプが点灯せず、かつレベル波形が小さすぎないレンジに設定します。 

  ・RANGE または STOP キーを押して、変更処理を終了します。 

 

■ トリガ条件の設定 

・[Trigger]にカーソルを移動してENTER キーを押して、右の 

トリガ設定画面を表示させます。 

  ・トリガを使用する場合、[Mode]にカーソルを移動してENT 

キーを押して、▲ ▼キーを使って [Single] / [Repaet]の何れか 

を選択します。トリガを使用しない場合は、[Free]に設定 

します。 

・トリガを使用する場合、[Type]にカーソルを移動してENT キーを押して、▲ ▼キーを使って[Level] / 

[ External] /[ External Gate] / [Time]の何れかを選択します。この設定により以下のように設定が異なります。 

○Levelトリガの場合 

  設定したチャンネルの入力信号が、設定したレベルを超えた場合に収録を開始します。設定した収録時間

収録して、停止します。 

・[Level]にカーソルを移動してENT キーを押して、▲ ▼キーを使ってトリガレベルを設定します。 

・[Ch]にカーソルを移動してENT キーを押して、▲ ▼キーを使ってトリガチャンネルを設定します。 

・MENU キーを押して、メニュー画面を表示させます。 
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MENU Bar  Graph 

CH    Graph 

1：   Log 

2：   Linear 

3：   Linear 

4：  Linear 

Level                   

50.0  ％ 

Ch                      

Ch.1 

○Externalトリガの場合 

  外部からのトリガ信号により収録を開始します。設定した収録時間収録して、停止します。 

○External Gateトリガの場合 

外部からのトリガ信号により収録を開始し、外部信号により、収録を停止します。 

○Timeトリガの場合 

設定した収録開始時刻から収録を開始し、設定収録時間経過後に収録を停止します。ただし、ModeをRepeat 

に設定した場合、設定終了時刻まで設定したインターバル時間ごとに収録動作を繰り返します。 

・[Start Time]と[Stop Time]にカーソルを移動してENT キーを押して、▲ ▼キーを 使ってスタート時刻と、 

ストップ時刻を設定します。さらに、[Sleep]にカーソルを移動してENT キーを押して、▲ ▼キーを使っ 

てスリープモードに使用の有無を設定します。さらに、前記[Mode]で[Repeat]を選択した場合は「Interval」

にカーソルを移動してENT キーを押して、▲ ▼キーを使ってインターバル時間を設定します。 

・MENU キーを押して、メニュー画面を表示させます。 

 

■ バーグラフの設定 

・[Bar  Graph]にカーソルを移動してENTER キーを押して、右の画面 

を表示させます。 

・各CHにカーソルを移動してENT キーを押して、▲ ▼キーを使って 

各グラフをLinearで表示するか、Logで表示するかを設定します。 

・MENU キーを押して、メニュー画面を表示させます。 

・再度MENU キーを押して、メニュー画面から抜けます(測定画面に 

なります)。 
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YES 

YES 

YES 

YES 

YES 

YES 

データの収録 

以下の YES/NO から収録時間とトリガ設定を導き、設定してください。各設定の動作は次ページ以降の該当する番号で確認してください。 

 

 

 

 

 

 

 

                                                                              

                              

                                                                

                                                                          

                               

                                        

               

                

                                

 

     

 

 

 

 

 

トリガを 

使用しますか 

外部信号で 

行いますか 

設定収録時間が経過

したら停止しますか 
収録開始時刻を

設定しますか 

騒音計(NL-42/52/62)

や 振 動 レ ベ ル 計

(VM-53)のコンパレ

ータ出力を使って、

設定レベルを超えて

いる間収録を行いま

すか 

設定収録時間が経過

したら停止しますか 

設定時間が経過した

ら停止しますか 

⑥収録時間:[設定時間収録]、トリガ設定:[Free] 

①収録時間:[Manual]、トリガ設定:[Free] 

⑨収録時間:[設定時間収録]、トリガ設定:[Repeat][Level] 

⑦収録時間:[設定時間収録]、トリガ設定:[Single][Level] 

⑤収録時間:[Manual]、トリガ設定:[Repeat][External Gate] 

④収録時間:[Manual]、トリガ設定:[Single][External Gate] 

②収録時間:[Manual]、トリガ設定:[Single][Level] 

トリガ収録は

1 回ですか 

トリガ収録は

1 回ですか 

⑧収録時間: [設定時間収録] 、トリガ設定:[Single][External] 

③収録時間:[Manual]、トリガ設定:[Single][External] 

 
⑩収録時間: [設定時間収録]、トリガ設定:[Repeat][External] 

YES 

YES 

NO 

NO 

NO 

NO 

NO 

YES 

NO 

NO 

NO 

トリガ収録は

1 回ですか 

トリガ収録は

1 回ですか 

⑫収録時間:[設定時間収録]、トリガ設定:[Single][Time] 

⑪収録時間:[Manual]、トリガ設定:[Single][Time] 

⑬収録時間:[設定時間収録]、トリガ設定:[Repeat][Time] 

設定収録時間が経過

したら停止しますか 

NO 

NO 

YES 

YES 

YES 

NO 

NO 
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データの収録方法は、メニュー内の[Rec.Parameters]の[Recording Time]の設定(Manual / 設定時間収録の2種類)と

[Trigger]の[Mode]の設定(Free / Single / Repeatの3種類)と[Trigger]の[Type]の設定(Level / External / External Gate / 

Timeの4種類)の組み合わせにより異なり、以下の13種類あります。 

 

①収録時間:[Manual]、トリガ設定:[Free] 

REC キーを押すと収録を開始して、STOP キーを押すまで収録を続けます。ただし、カードの残容量がなく

なると自動的に停止します。 

 

②収録時間:[Manual]、トリガ設定:[Single][Level] 

REC キーを押した後、入力信号レベルが設定レベルを超えた時に収録を開始して、STOP キーを押すまで収

録を続けます。ただし、カードの残容量がなくなると自動的に停止します。 

 

③収録時間:[Manual]、トリガ設定:[Single][External] 

REC キーを押した後、外部トリガ信号が入力されると収録を開始して、STOP キーを押すまで収録を続けま

す。ただし、カードの残容量がなくなると自動的に停止します。 

 

④収録時間:[Manual]、トリガ設定:[Single][External Gate] 

REC キーを押した後、外部トリガ信号が入力されると収録を開始して、外部トリガ信号が復帰して5秒経過

すると自動的に停止します。この場合、設定収録時間は無視されます。ただし、収録の途中でSTOP キーを

押すまたはカードの残容量がなくなると停止します。 

 

⑤収録時間:[Manual]、トリガ設定:[Repeat][External Gate] 

REC キーを押した後、外部トリガ信号が入力されると収録を開始して、外部トリガ信号が復帰して5秒経過

した場合はその時点で停止し、収録番号を+1してトリガ待ち状態となり、再度外部トリガ信号が入力されると

収録を開始し、STOP キーが押されるまでこの動作を繰り返します。ただし、外部トリガ信号が復帰して5秒

経過するまでに STOP キーを押すまたはカードの残容量がなくなると自動的に停止します。 

 

⑥収録時間:[設定時間収録]、トリガ設定:[Free] 

REC キーを押すと収録を開始して、設定収録時間になると自動的に停止します。ただし、収録の途中で STOP

キーを押すまたはカードの残容量がなくなると停止します。 

 

⑦収録時間:[設定時間収録]、トリガ設定:[Single][Level] 

REC キーを押した後、入力信号レベルが設定レベルを超えた時に収録を開始して、設定収録時間になると自

動的に停止します。ただし、収録の途中でSTOPキーを押すまたはカードの残容量がなくなると停止します。 

 

⑧収録時間:[設定時間収録]、トリガ設定:[Single][External] 

REC キーを押した後、外部トリガ信号が入力されると収録を開始して、設定収録時間になると自動的に停止

します。ただし、収録の途中で STOP キーを押すまたはカードの残容量がなくなると停止します。 

 

⑨収録時間:[設定時間収録]、トリガ設定:[Repeat][Level] 

REC キーを押した後、入力信号レベルが設定レベルを超えた時に収録を開始して、設定収録時間になると自

動的に停止し、収録番号を+1してトリガ待ちとなり、再度入力信号レベルが設定レベルを超えると収録を開

始し、STOP キーが押されるまでこの動作を繰り返します。ただし、収録の途中でカードの残容量がなくな
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ると停止します。 

 

⑩収録時間:[設定時間収録]、トリガ設定:[Repeat][External] 

REC キーを押した後、外部トリガ信号が入力されると収録を開始して、設定収録時間になると自動的に停止

し、収録番号を+1してトリガ待ちとなり、再度外部トリガ信号が入力されると収録を開始し、STOP キーが

押されるまでこの動作を繰り返します。ただし、収録の途中でカードの残容量がなくなると停止します。 

 

⑪収録時間:[Manual]、トリガ設定:[Single][Time] 

REC キーを押した後、設定収録開始時刻になると収録を開始して、設定収録停止時刻になると自動的に停止

します。ただし、収録の途中で STOP キーを押すまたはカードの残容量がなくなると停止します。 

 

⑫収録時間:[設定時間収録]、トリガ設定:[Single][Time] 

REC キーを押した後、設定収録開始時刻になると収録を開始して、設定収録時間になると自動的に停止しま

す。ただし、収録の途中で STOP キーを押すまたはカードの残容量がなくなると停止します。 

 

⑬収録時間:[設定時間収録]、トリガ設定:[Repeat][Time] 

REC キーを押した後、設定収録開始時刻になると収録を開始して、設定収録時間になると自動的に停止し、

収録番号を+1してトリガ待ちとなり、設定インターバル間隔になると収録を開始し、STOP キーが押される

までこの動作を繰り返します。ただし、収録の途中でカードの残容量がなくなると停止します。 
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収録データの確認・分析・削除 

収録データの確認は、イヤホンを使用して聞くことができます。 

収録データの分析は、専用の周波数分析器やレベルレコーダに収録データを再生して分析するか、専用のソフ

トウェア(AS-70またはCAT-WAVE )を使用して分析します。各々を以下に示します。 

 

■ 収録データをイヤホンで確認 

  Monitor Out端子にイヤホンを接続すると、収録データを聞くことが可能です。その方法を以下に示します 

   ・イヤホンをMonitor Out端子に接続します。 

  ・RECALL キーを押して収録データリスト画面を表示させ、▲ ▼キーを使って再生したいデータにカーソ

ルを移動してENT キーを押すとリコール画面が表示され、PLAY キーを押すと再生が開始されます。＞

キーを押すと早送り、＜キーを押すと巻き戻しを行います。もっと高速で早送りと巻き戻しを行いたい場

合、PAUSE キーを押して一旦停止してから＞ ＜キーを押し高速で送った後再度 PAUSE キーを押して再

生します。再生が終わると自動的に停止します。 

・終了時はRECALL キーを2回押すと、メイン画面に戻ります。 

 

■ 収録データをWindows Media Playerで確認 

   収録したデータについては、パソコンのWindows Media Playerで確認できます。 

 

■ 収録データを再生して分析 

  収録したデータを再生できますので、お持ちの周波数分析器やレベルレコーダ等で分析することが可能です。

再生時は全チャンネルの信号が出力されます。 

  ・再生したいチャンネルの出力端子にCC-24Sケーブルを使って分析器等に接続します。 

  ・RECALL キーを押して、収録データリスト画面を表示させます。 

・収録データリスト画面で▲ ▼キーを使って再生するデータにカーソルを移動して、ENT キーを押すとリ

コール画面が表示され、PLAY キーを押すと再生が開始されます。＞キーを押すと早送り、＜キーを押す

と巻き戻しを行います。もっと高速で早送りと巻き戻しを行いたい場合は、PAUSE キーを押して一旦停

止してから＞ ＜キーを押し高速で送った後再度 PAUSE キーを押して再生します。 

・校正信号が収録されている場合は、その信号を用いてレベル変換を行います。再生が終わると自動的に停

止します。 

・終了時はRECALL キーを2回押すとメイン画面に戻ります。 
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Delete  Data? 

 

Yes   → [ENT] 

No    → [PAUSE] 

■ 専用ソフトウェアを使用して分析 

 収録データはWAVE形式で保存されますので、WAVE形式のデータを分析可能なソフトウェアで分析しま

す。フリーウェアやシェアウェアのソフトウェアでWAVE形式のファイルを分析可能なものもありますが、3

チャンネル以上のデータやサンプリング周波数によっては、対応されていませんのでご注意ください。対応し

ていても校正値は反映できません。よって、弊社販売のAS-70のご使用をお勧めします。ただし、AS-70を既

にお持ちの方は、対応済みのバージョン（1.3.1.9）以降であるかご確認下さい。以前のバージョンをお持ちの

場合、バージョンアップが必要です。弊社ホームページから無償で最新バージョンのダウンロードが行えます

ので、ご利用下さい。 

専用ソフトでオクターブバンド分析する場合、DA-21で選択した周波数レンジにより分析できる上限の周波

数バンドが異なります。  

オクターブバンド  1/3オクターブバンド  

周波数 

レンジ 

上限周波数 

バンド 
 

周波数 

レンジ 

上限周波数 

バンド 
 

100 63  100 100  

500 250  500 400  

1000 500  1000 1000  

5000 4000  5000 4000  

10000 4000  10000 10000  

20000 16000  20000 20000  

 

■ 収録データの削除 

  収録データの削除は、以下の方法で行えます。 

  ・RECALL キーを押して、収録データリスト画面を表示させます。 

・収録データリスト画面で▲ ▼キーを使って削除したいデータにカーソルを移動して、RANGE キーを押

すと右のメッセージが表示されますので、ENT キーを押すとデータは消去されます。 

・終了時はRECALL キーを押すと、メイン画面に戻ります。 
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各種メニュー設定 

Input(MENU ⇒ Input) 

・入力信号の種類を設定する。            Input ⇒ [OFF]/[AC]/[DC]/[CCLD]/[VP4x] 

・ハイパスフィルタの周波数を設定する。  HPF ⇒ [OFF]/[5Hz] 

・ローパスフィルタの周波数を設定する。  LPF ⇒ [OFF]/[200Hz]/[1kHz]/[2kHz] 

・センサの種類を設定する。              Sens ⇒ [OFF/EU/SLM/VM/MIC/PICK] 

・センサ感度を設定する。                Sensitivity ⇒ [V/EU/dB/(pc/m/s^2)/(mv/m/s^2)] 

Rec.Parameters(MENU ⇒ Rec.Parameters) 

・周波数レンジを設定する。              Frequency Range ⇒ [100Hz]/[500Hz]/[1kHz]/[5kHz]/[10kHz]/[20kHz] 

・サンプリング周波数を設定する。        Sampling Frequency ⇒ [×2.4]/[×2.56] 

・データ長を設定する。                  Bit Length ⇒ [16bit]/[24bit] 

・データ分割時間を設定する。        Wave Splitting Interval ⇒ [10min]/[1h] 

・収録時間を設定する。                  Recording Time ⇒ [1～59s]/[1～59m]/[1～24h]/[Manual] 

・プリ収録時間を設定する。              Pre Recording Time ⇒ [0s]/[1s]/[5s] 

Trigger(MENU ⇒ Trigger) 

・トリガ動作の種類を設定する。          Mode ⇒ [Free]/[Single]/[Repeat] 

・トリガ信号の種類を設定する。          Type ⇒ [Level]/[External]/[External Gate]/[Time] 

・トリガレベルを設定する。              Level ⇒ [0.1～0.9%]/[1～99%] 

・トリガチャンネルを設定する。 Ch ⇒ [Ch1]/[Ch2]/[Ch3]/[Ch4] 

・収録開始時間を設定する。              Start Time ⇒ [2014/4/7 10:00] 

・収録停止時間を設定する。              Stop Time ⇒ [2014/4/8 09:59] 

・インターバルを設定する。       Interval ⇒ [5m]/[10m]/[15m]/[30m]/[1h]/[8h]/[24h] 

・スリープ機能を設定する。       Sleep ⇒ [ON]/[OFF] 

Bar Graph(MENU ⇒ Bar Graph) 

・チャンネルごとに設定する。            [Linear]/[Log] 

System(MENU ⇒ System) 

・設定値の読込、保存する。           Read / Save Setting ⇒ Load Default Settings ⇒ [Yes]/[No] 

                              Internal Memory ⇒ [No.a]/[No.2]/[No.3]/[No.4]/[No.5] 

                                                           SD CARD ⇒ [Save Setting]/[Cancel] 

・現在時刻を設定する。            Clock Settings ⇒ Date ⇒  [2014/04/07] 

Time ⇒ [09:50：00] 

・バックライトに関する設定をする。      Backlight Settings ⇒ Brightness ⇒ [1]/[2]/[3]/[4] 

                                                          Auto Off  ⇒ [30s]/[3m]/[Continue] 

・電池種類を設定する。                  Battery Type ⇒ [Alkaline]/[Ni-MH] 

・カードをフォーマットする。        Card Format ⇒ [Yes]/[No] 

・USBストレージを設定する。       USB Storage ⇒ [ON]/[OFF] 

・モニタ出力を設定する。                Monitor Out ⇒ [ON]/[OFF] 

・インデックスを設定する。              Index ⇒ [1～255] 

・本器のバージョンを表示する。     Version 

Synchronization(MENU ⇒ Synchronization ) 

・マスタ、スレーブを設定する。          Master/Slave ⇒ [OFF]/[Master]/[Slave] 

・同期を設定する。                      Synchronize ⇒ [Yes]/[No] 


